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Welcome to
Virtual Jukebox

Virtual Jukebox (VJB) allows you to quickly create a playlist of song files for playback.    The format of 
these song files can be either Cakewalk WRK and BUN files, standard MID files, or digital audio WAV 
files.    The playlist can be comprised of any combination of these file names.

Use the VJB to quickly audition WAV files from a CD-ROM or quickly audition from a large selection of 
MIDI files.

Run with Cakewalk! (Windows 95 only)    You can run Cakewalk concurrently with the Virtual 
Jukebox.    Run the Virtual Jukebox from the Tools menu in Cakewalk.    With Drag and Drop 
support, you can drag your desired WAV files from a VJB playlist into a Cakewalk audio view, as a 
means of quickly inserting digital audio.

While using Virtual Jukebox, you may get context-sensitive help on any menu item by pressing the F1 
function key.

Point and click on any of the following items for help:

· Inserting files into the Playlist 

· Setting Playback Modes 

· Transport control 

· Configuring MIDI devices
· Keyboard shortcuts
· File Menu
· Edit Menu
· Options Menu



Inserting files into the playlist

When you first open Virtual Jukebox, the playlist is empty.    To create a new playlist, you must add files to 
it.    These files can be Cakewalk .WRK and .BUN files, standard .MID files, or digital audio .WAV files.    
Click your mouse on the folder button, which is the second button from the right on the transport control.
You can also go to File | Add Files to Playlist or press the "Insert" button on your keyboard to achieve 
the same result.    An open file dialog shall appear.    Select the appropriate subdirectory where the song 
files are located.    In order to exit from the open file dialog, you must select the close button.    There are 
multiple ways in which files can be added to the playlist:

Windows 95 edition:
1. Highlighting a file name and then pressing the button "Add".
2. Double clicking on a file name.
3. Select multiple files by holding down either the CTRL or ALT keys while clicking on the file names, 

and then press the Add button.

Tip: Quickly select all files in a directory in the Open File dialog by pressing Ctrl A.    Once the playlist is loaded, highlight 
the desired song file and play it!

Windows 3.1 edition:
1. Highlighting a file name and then pressing the button "Add".
2. Double clicking on a file name.
3. Adding all the song files of a subdirectory by pressing the "Add All" button.

Tip: The "Add All" command is a useful way to quickly audition many files at one time.    Once the playlist is loaded, 
highlight the desired song file and play it!

Note on Long File Names.    Long file names are only supported in Windows 95.    Long file names can be 256 characters
long, are case sensitive, and can have spaces.    Playlists created with Long File Names may not be compatible with the 
Windows 3.1 edition of the VJB, as Windows 3.1 does not support long file names.

Drag and Drop (both editions)
You can also drag files from the Windows 3.1 File Manager or the Windows 95 Explorer into the 
Virtual Jukebox.    Select multiple files by holding down either the CTRL or ALT keys while clicking 
on the file names.    Select all files in a current directory by pressing Ctrl A.

The icon representation for the three types of files that can be loaded into the playlist are:
 Cakewalk .WRK or .BUN file
 Standard MIDI .MID file
 Microsoft Digital Audio .WAV file

Note: The maximum number of song file names the playlist can store is 999 songs!

See Also:
Edit Insert
Help Contents



Transport control

The transport control consists of six buttons arranged in a horizontal fashion.    There is also a time 
display and a time scrollbar as part of the user interface.    From left to right, the function of these 
buttons are:

    Rewind/Back Rewind/Go back to previous song in playlist.
    Next Advance to next song in playlist.
    Play Play back the highlighted song in the playlist.
    Stop Stop playback of the highlighted song in the playlist.
    Insert Insert song files into the playlist before the highlighted song file.
    Delete Delete highlighted song file name from the playlist.

See Also:
Keyboard shortcuts
Help Contents



Keyboard shortcuts

Function Keys
F1 Help
F3 Repeat Last Find

ALT+F4 Exit
F6 Switch window

Other Keys
CTRL+N New
CTRL+O Open
CTRL+A Add
CTRL+S Save
CTRL+Z Undo
CTRL+A Redo
CTRL+F Find
ALT + S Sort

CTRL+C Copy
CTRL+X Cut
CTRL+V Paste

INSERT Insert a file into the playlist
DELETE Delete a file from the playlist

HOME Go to beginning of the playlist
END Go to end of the playlist

LEFT, UP Previous song
RIGHT, DOWN Next song

SPACEBAR Play and stop
W Rewind to beginning

See Also:
Transport Control
Help Contents



File menu

The File menu contains commands relating to files.

New Start with a new playlist.
Open Load a playlist from a disk file.
Add Add files to the playlist.
Save Save a playlist to a disk file.
Save As Save a playlist under a new name.
Exit Exit the program.

See Also:
Help Contents



Edit menu

The Edit menu contains commands relating to moving and changing song file names within the playlist.

Undo Last Undo last edit action.
Redo Redo last edit action.
Cut Move a song file name to the scrap buffer.
Copy Copy a song file name to the scrap buffer.
Paste Move a song file name from the scrap buffer to the playlist
Insert Insert into the playlist a song file name.
Delete Delete from the playlist a song file name.
Find Find a song file name in the playlist.
Repeat Last Find Repeat last find of a song file name in the playlist.
Sort Sort items in the playlist.
Rewind Rewind to beginning.

See Also:
Drag and Drop editing
Help Contents



Options menu

The Options menu contains commands relating to how the playlist is displayed, how songs files can be 
played back, and various other configurations that pertain to Cakewalk .WRK files specifically.

Always on Top Always display as top most window.
Show Full Path Show the full path of a song file name.
Randomize Play Play songs in a random sequence.
Set Playback Mode (All Files) Set how song files are to be played back.
Show Cakewalk File Information Show Cakewalk file information.
Sequence Time Display Set time display format for MIDI sequences.
Configure MIDI Devices Set MIDI device configuration.

See Also:
Help Contents



New (File menu)

Use this command to start a new playlist.    If your current playlist has changed since you have last saved 
it, you will be given a chance to save it first.

Shortcut:
Key: CTRL+N

See Also:
File menu



Open (File menu)

Use this command to load Virtual Jukebox .PLY playlist files or Cakewalk .SET files.

Loading a file replaces the file currently in memory.    If you have made changes since the file was last 
saved, you will be given a chance to save before loading a new playlist.

Note on Long File Names.    Long file names are only supported in Windows 95.    Long file names can be 256 characters
long, are case sensitive, and can have spaces.    Playlists created with Long File Names may not be compatible with the 
Windows 3.1 edition of the VJB, as Windows 3.1 does not support long file names.

Shortcut:
Key: CTRL+O

See Also:
File menu



Save (File menu)

Use this command to save a changed file under its existing name.

If you created a brand-new playlist using the New command, it has no name.    In that case, the Save As 
file dialog shall appear.

Note on Long File Names.    Long file names are only supported in Windows 95.    Long file names can be 256 characters
long, are case sensitive, and can have spaces.    Playlists created with Long File Names may not be compatible with the 
Windows 3.1 edition of the VJB, as Windows 3.1 does not support long file names.

Shortcut:
Key: CTRL+S

See Also:
File menu



Save As (File menu)

Use this command to save your playlist under a new name.    If you do not supply an extension for the file 
name, the ".PLY" extension will be automatically appended to your name.

Note on Long File Names.    Long file names are only supported in Windows 95.    Long file names can be 256 characters
long, are case sensitive, and can have spaces.    Playlists created with Long File Names may not be compatible with the 
Windows 3.1 edition of the VJB, as Windows 3.1 does not support long file names.

See Also:
File menu



Exit (File menu)

Use this command to exit Virtual Jukebox.    If your playlist has changed since you last saved it, you will 
be asked if you want to save it before Virtual Jukebox exits.

See Also:
File menu



Undo Last (Edit menu)

Use this command to undo your last edit action in the playlist.    Edit actions that can be undone include 
cutting, deleting, and moving song files within the playlist.

Shortcut:
Key: CTRL+Z

See Also:
Edit Redo
Drag and Drop editing
Edit menu



Redo (Edit menu)

Use this command to redo your last edit action in the playlist.        Edit actions that can be redone include 
cutting, deleting, and moving song files within the playlist.

Shortcut:
Key: CTRL+A

See Also:
Edit Undo
Drag and Drop editing
Edit menu



Cut (Edit menu)

Use this command to move a song file name from the playlist into the file name scrap buffer.

Once you have done a cut operation, you can paste the song file name from the scrap buffer
back into the playlist.    This operation can be undone.

Shortcut:
Key: CTRL+X

See Also:
Edit Paste
Drag and Drop editing
Edit menu



Copy (Edit menu)

Use this command to copy a song file name from the playlist into the file name scrap buffer.  

Once you have done a copy operation, you can paste the song file name from the scrap 
buffer back into the playlist.    This operation can be undone.

Shortcut:
Key: CTRL+C

See Also:
Edit Paste
Drag and Drop editing
Edit menu



Paste (Edit menu)

Use this command to transfer a song file name from the file name scrap buffer into the 
playlist.

You must first cut or copy song file name in the playlist before you can use the paste 
operation.    This operation can be undone.

Shortcut:
Key: CTRL+V

See Also:
Edit Cut
Edit Copy
Drag and Drop editing
Edit menu



Insert (Edit menu)

Use this command to insert a new song file name to the playlist before the currently 
highlighted item.

Shortcut:
Key: INSERT

See Also:
Inserting files into the playlist
Edit menu



Delete (Edit menu)

Use this command to delete the currently highlighted song file name in the playlist.    This 
operation differs from the cut operation, in that the file name is not transferred to the file 
name scrap buffer.    This operation can be undone.

Shortcut:
Key: DELETE

See Also:
Edit Cut
Edit menu



Find (Edit menu)

Use this command to search a song file name in the playlist by typing part of the file name 
which is unique to it.    This is handy for quickly finding a song from a large playlist.    The 
search will loop through the playlist.    If a match is found, it will be highlighted.

Tip: If playback is active and if a search is engaged, the first song found will then automatically start 
playback.

Search options:

· Include search in path.    Check this option if you want your search to include the 
full directory path of the song file names.

· Search backwards.    Search backwards in the playlist from the current playlist 
selection.

· Case sensitive (Windows 95 only).    Choose this option if you want to have case 
sensitive searching.

Shortcut:
Key: CTRL+F

See Also:
Repeat last find
Edit menu



Repeat Last Find (Edit menu)

Use this command to repeat the last find of a song file name in the playlist.    If the previous 
search criteria was not successful, you will be prompted to type in a new search token.    This
command will continue to loop through the playlist, if the beginning or end of the list has 
been reached.

This command follows the same search options set in Edit | Find.

Shortcut:
Key: F3

See Also:
Edit Find
Edit menu



Sort (Edit menu)

Use this command to sort the playlist.    If the full paths are displayed, the file names will be 
sorted with the paths.    To sort by file name only, do not display with full paths.

Shortcut:
Key: ALT + S

See Also:
Edit menu
Show Full Path



Rewind to Beginning(Edit menu)

Use this command to rewind to the beginning of the currently loaded file.

Shortcut:
Key: W

See Also:
Edit menu



Always on Top (Options menu)

Use this command to toggle whether the Virtual Jukebox should always be displayed as the top most 
window.    This is useful if you always want to have the VJB in view, as you are working in other 
applications, such as dragging files into Cakewalk (Windows 95 only).

This setting is saved once Virtual Jukebox is closed.

See Also:
Options menu



Show Full Path (Options menu)

Use this command to toggle the path display of a file name in the playlist.    The full path includes the drive
letter, directory, file name, and extension in which the file name is in bold.    When Show Full Path is 
toggled off, only the file name in bold is displayed.

This setting is saved once Virtual Jukebox is closed.

See Also:
Options menu



Randomize Play (Options menu)

Use this command to toggle the randomization of the next song to be selected once the currently playing 
song has expired.

This is not a true shuffle mode in that songs are not guaranteed to be played once only.    The same song 
however will never be played twice in succession.

This setting is saved once the Virtual Jukebox is closed.

See Also:
Options menu



Set Playback Mode (Options menu)

Use this command to select the how the playlist advances to the next song once the currently playing 
song has expired.        There are three different modes:

 Autoadvance Play next song in playlist upon expiration of current song.
 Wait for Keypress Next song won't play until the SPACEBAR is pressed, or the play button is 

pressed.
 Set time delay Next song is delayed before playback.

By default, the playback mode is autoadvance.

Note:      Mode selection affects all the song file names in the playlist.    To individually set the 
playback mode for a single song file name, click the right mouse button on the song file name.

See Also:
Popup Menu (Set Playback Mode)
Options menu



Show Cakewalk File Information (Options menu)

This option displays song information on Cakewalk .WRK and .BUN files as well as Standard .MID files.    
The song information includes title, subtitle, instructions, copyright, key words, and comments.    By 
default, the File Information dialog box displays when a file is loaded.

You may toggle the Cakewalk File Information dialog on or off.    This setting is saved once Virtual 
Jukebox is closed.

See Also:
Options menu



Sequence Time Display (Options menu)

There are two time options for the time display of Cakewalk .WRK and standard .MID files:

1. Hours:Minutes:Seconds:Frames.    This is the SMPTE format set for the 
Cakewalk .WRK, .BUN, or Standard .MID file.    There are typically 30 frames per second, 
depending on the SMPTE format chosen in Cakewalk.    Do not confuse frames with hundredths 
of a second in time.

2. Measures:Beats:Ticks.    This is a musical time display that reflects the meter of the MIDI 
sequence.    The tick resolution is the resolution of the quarter note, which is typically 120 ppq., 
depending on the resolution chosen in Cakewalk.

The default setting is Hours:Minutes:Seconds:Frames.    You may toggle between the two 
time displays.    This setting is saved once Virtual Jukebox is closed.

See Also:
Time Display
Options menu



Sequence Time Display (Options menu)

There are two time options for the time display of Cakewalk .WRK and standard .MID files:

1. Hours:Minutes:Seconds:Frames.    This is the SMPTE format set for the 
Cakewalk .WRK, .BUN, or Standard .MID file.    There are typically 30 frames per second, 
depending on the SMPTE format chosen in Cakewalk.    Do not confuse frames with hundredths 
of a second in time.

2. Measures:Beats:Ticks.    This is a musical time display that reflects the meter of the MIDI 
sequence.    The tick resolution is the resolution of the quarter note, which is typically 120 ppq., 
depending on the resolution chosen in Cakewalk.

The default setting is Hours:Minutes:Seconds:Frames.    You may toggle between the two 
time displays.    This setting is saved once Virtual Jukebox is closed.

See Also:
Time Display
Options menu



Configure MIDI Devices (Options menu)

Use this command to select MIDI input and output devices for Cakewalk .WRK and .BUN files and 
standard .MID files.

Input and Output devices
You may pick any number of available MIDI input and output devices.    However:

·    For playback to work, you must select at least one Output device.

·    For MIDI thru to work, you must select at least one Input device.

The lists of devices show drivers which you have already installed using the "Drivers" icon of the Windows
Control Panel.    The MIDI Devices dialog    lists only MIDI input and output devices, not other kinds of 
devices.

MIDI Out devices are assigned to Cakewalk port numbers in the order they are listed.    For example, if 
"MPU-401" is above "Sound Blaster" in the list and you select both, port 1 in Cakewalk is the MPU-401 
and port 2 is the Sound Blaster.    To rearrange the order, select one or more items, then press the Move 
Selected to Top button.

Note: The channel that is active for playback reflects the MIDI channel associated with last edited track of the .WRK 
or .BUN file in Cakewalk.

See Also:
System Exclusive Autosend
MIDI Thru
Options menu



Drag and Drop editing with the mouse

Virtual Jukebox Drag and Drop support allows you to move or copy files within the playlist or among other
applications that support Drag and Drop of file names.

Drag and Drop within the playlist.

Moving: Bring the mouse cursor over the song file name to be moved, press the left mouse button 
and leave it depressed.    The cursor arrow will appear with a little rectangle icon beneath it.    Drag the
cursor to the new location in the playlist where you want to move (drop) the song file name to, and 
release the mouse button.

Copying: Holding down the Ctrl key, bring the mouse cursor over the song file name to be copied, 
press the left mouse button and leave it depressed.    The cursor arrow will appear with a little 
rectangle with a plus icon beneath it.    Drag the cursor to the new location in the playlist you want to 
copy the song file to, and then release the mouse button and Ctrl key.

Drag and Drop from File Manger or Explorer.

You can also drag files from the Windows 3.1 File Manager or the Windows 95 Explorer into the 
Virtual Jukebox.    Select multiple files by holding down either the CTRL or ALT keys while clicking on 
the file names.    Select all files by pressing Ctrl A.

Drop files from the VJB into Cakewalk. (Windows 95 only)

There are three ways the VJB can be used to load files into Cakewalk through Drag and Drop:

· Dragging a .WAV file from the VJB to a specified cursor position in an open Audio View in 
Cakewalk as a means of inserting audio.

· Dragging .WRK, .MID, or .BUN files from the VJB to Cakewalk as a means of loading a file.

· Dragging .WRK, .MID, or .BUN files from VJB to a Cakewalk playlist as a means of adding a file 
to the playlist.

See Also:
Edit Copy
Edit Move



Time Display

The time display for digital audio .WAV files are minutes:seconds:hundreths.    Sequence time display for
.Cakewalk .WRK and .BUN files and standard .MID files are in either in SMPTE or in meter format.

See Also:
Time Scrollbar
Transport Control



Time Scrollbar

The time scrollbar allows you to seek to different times within a song during playback or stopped play.

Your can either drag the thumb stop of the scroll bar or press the left or right arrows on the scroll bar.    
Movement of the thumb stop to the left indicates going back in time.    Movement to the right indicates 
moving ahead in time.

The time display automatically updates as the time position changes.

See Also:
Transport Control



MIDI Mapper

Virtual Jukebox plays back standard MIDI .MID files using the Media Control Interface (MCI).    For the 
playback of .MID files, MCI looks for MIDI configuration data through the MIDI Mapper.

The MIDI Mapper is Microsoft's MME software that modifies MIDI output messages and redirects them to 
a MIDI output device using values stored in a MIDI setup map.    Use the MIDI Mapper applet in the 
Control Panel to create and edit MIDI setup maps.

The most likely reasons for MCI errors of .MID file playback are.

1. The MIDI driver selected in the MIDI mapper is not yet installed in Windows.
2. The MIDI driver selected in the MIDI mapper is incorrect.
3. The MCI MIDI Sequencer driver is not installed in Windows.

See also:
Configure Cakewalk MIDI devices
Contents



System Exclusive Autosend

System exclusive banks that were marked as auto in a Cakewalk System Exclusive view, will 
automatically be sent when a .WRK file is loaded in Virtual Jukebox.

See Also:
Configure Cakewalk MIDI Devices
Contents



MIDI Thru

MIDI thru allows you to play your MIDI controller through the MIDI interface when Virtual Jukebox is first 
loaded.    The channel that is active for playback reflects the MIDI channel associated with last edited 
track of the .WRK or .BUN file in Cakewalk.

See Also:
Configure Cakewalk MIDI Devices
Contents



Auto Advance

In this playback mode, when the highlighted song expires from its playback, the next song in the playlist 
shall automatically load and then play.

See also:
Set Playback Mode (Options menu)
Set Playback Mode (Popup menu)



Wait for Keypress

In this playback mode, when the highlighted song expires from its playback, the next song in the playlist 
shall automatically load.

The newly loaded file will not play until the SPACEBAR or play button is pressed.

See also:
Set Playback Mode (Options menu)
Set Playback Mode (Popup menu)



Wait for Time Delay

In this playback mode, when the highlighted song expires from its playback, the next song in the playlist 
shall automatically load and commence the time delay countdown in seconds.

When this mode is chosen, you will be prompted by a dialog box for the delay time.    This value is in 
seconds.

The newly loaded file will not play until countdown is completed.    You may initiate playback in the middle 
of the countdown by pressing the SPACEBAR or the play button.

See also:
Set Playback Mode (Options menu)
Set Playback Mode (Popup menu)



Popup menu

The popup menu allows you to set the playback mode for the currently highlighted song file in the playlist. 
This is in contrast to the Set Playback Mode in the Options menu, where the setting affect all of the song 
files in the playlist.

Bring the mouse over the song file name you want to set the playback mode for, and press the right 
mouse button.    A popup menu, similar to Options|Set Playback Mode shall appear.

See also:
Help Contents



Initialization file VJB.INI (Windows 3.1)

This file is located in the directory where you installed Cakewalk.    It contains information that Virtual 
Jukebox needs to store between sessions, for example, your preferences.    Many items are stored here 
from choices you make in Virtual Jukebox menus.

The preferences that are stored from session to session includes:

· The window dimensions of Virtual Jukebox's main window and Cakewalk File Information dialog.
· The four most recent .PLY playlist files that were loaded.
· Show full path enable status.
· Randomize play enable status
· Show Cakewalk File Information enable status
· Time display format for Cakewalk .WRK files.
· Search optionsStore search options.

Note: Registry and Window 95.    The Windows 95 edition of the Virtual Jukebox does not use an INI file and stores 
preference information in the Windows 95 Registry.

See also:
Help Contents



For more information on Cakewalk, please call Cakewalk Music Software at 800-234-1171 or 617-926-
2480.    For 24-hour Fax-Back customer service call 800-370-6912.

Cakewalk is the leading music software for Windows and Multimedia PCs.    You can use Cakewalk to 
produce multi-track recordings from your desktop.    You can record directly from a MIDI instrument, or 
enter notes from the computer. It works with any Windows-compatible MIDI interface or sound card.

New Cakewalk Pro Audio brings multi-track digital audio recording into the Cakewalk Music Software 
product line.    So now you can add vocals, guitar, horns, or any other audio track right into your Cakewalk
MIDI sequence.

The Cakewalk software product line is designed for professional musicians, composers, film and video 
producers, audio engineers, game developers, multimedia authors, PC hobbyists, and music enthusiasts. 
No matter what your musical experience, you'll find a Cakewalk product that will let you tap into the music
that's in all of us.



This electronic help document is Copyright Ó 1992-1996 by Twelve Tone Systems, Inc.    All rights 
reserved.

Cakewalk, Cakewalk Pro Audio, Cakewalk Home Studio, Cakewalk Express, Cakewalk Song Station, 
Cakewalk Professional for Windows, Virtual Piano, Virtual Jukebox, and Cakewalk Music Software are 
trademarks of Twelve Tone Systems, Inc.

All of us here work hard to provide powerful but affordable software.    From the day in 1987 when 
Cakewalk for DOS 1.0 first shipped, we have never used copy-protection.    Our best protection is honest 
customers like you.    Thank you for your purchase of this product!




